Z

THE RAINMAKER SITE BUILDING ROADMAP

TIPS FOR SETTING UP YOUR BASIC
RAINMAKER SITE SETTINGS

PRESENTED BY JEROD MORRIS AND CHRIS GARRETT
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Each Month:
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Overview of The Rainmaker Site
Building Roadmap Webinar Series

February: Your Minimum Viable Website
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Overview of The Rainmaker Site
Building Roadmap Webinar Series

February: Your Minimum Viable Website

March: Setting Up and Maximizing Your Rainmaker Blog

April: Getting More Traffic, Visibility, and Sales

May: Email, Autoresponders, and Curated Newsletters

June: Selling Digital Downloads

July: Build Authority and Community Through Podcasting

August: Educating and Engaging Customers w/ an LMS Course
September: Sending the Right Message, To the Right People,

at the Right Time with Marketing Automation
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Agenda

Launching live and migrating
Quick Help and Help Mode
Settings overview

Tips for General settings
Tips for Results settings
Tips for admin settings

Two important default pages
Questions
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View Your Rainmaker Account

© @ | % Dashboard « Primility — Rain~ % Jerod

O
&« C {y @ jerod-morris.preview111.rmkr.net/admin/ *x B w lcell v

é/ 4+ Add New ¢ Edit /# Manage ©® Help

Admin Screen Options

¢¢ Quick Help

Help Mode

Dashboard :) h
a S Knowledge Base

Email Us

Design A/B Tests Your Account Google Analytics Summary v

Right Now in Membership Order History v
Content
Membership Order Summary v
Traffic Membership Order Statistics v
Membership Subscriptions Summary v
Conversion
Results
Education
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Confirm Preview Status / Launch Site to Live

~ @ ' % Account Portal X Jerod

O
& C Y @ my.newrainmaker.com/portal/ T & 9 w Col I

77 RAINMAKER PLATFORM Welcome back, Jerod!

from RAINMAKER DIGITAL

L Your Sites = RainMail ¥ Billing History & Your Account ®¥ Forum & LogOut

Your Rainmaker Sites

© Preview mode:

jerod-morris.previewlll.rmkr.net ¢———

Rainmaker Platform Additional (Pro Annual)
OPEN SITE DASHBOARD GET HELP

A Thissite is currently in preview mode. When you are ready to launch your site live on your own domain, click the Start Live Site Launch link below.

81 Start Live Site Launch ® Cancel This Site ©= Change Package/Billing Info '® Can't Access This Site!
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Access Knowledge Base

® © ® | 4 Dashboard « Primility — Rain X Jerod

< C )} @ jerod-morris.preview111.rmkr.net/admin/ * @B w colN v I

) + AddNew 2 Edit & Manage @ Help

Quick Help Admin Screen Options

Dasnboard [

Knowledge Base

%

A/B Tests Email Us bummary v

Your Account

Membership Order Summary v

Right Now in Forums pr History v

Membership Order Statistics v

Membership Subscriptions Summary v
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View Instructions for Live Site Launch

' ® ' % Knowledge Base < Primility — Jerod

O
&« C ) @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=rm_kb w W (w IColN + IR

+ Add New

& Edit # Manage ©® Help

Dashboard

Design

Content

Traffic

Conversion

Results

Education

Knowledge Base

S E—

Quick Answers

What version of Google Analytics does the How often is my Rainmaker Site backed up?
Rainmaker Platform support?

How do | launch my site to a live domain name?

How can | install a custom theme on my site?

Can | request a specific plugin or feature?

How do | change my billing?
Is there an Affiliate Program for the Rainmaker

n iti ite? Platform?
How much bandwidth and disk space are What's New in Rainmaker 2.11!

included with Rainmaker?

More ...

Topics

Learn Rainmaker v Conversion v
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View Instructions for Live Site Launch

74 Knowledge Base < Primility — X

C {0 @ jerod-morris.preview111.rmkr.net/admin/admin.php?search_term=launching+site+to+live&page=rm_kb&space_id&space_title

4+ Add New

Dashboard

Design

Content

Traffic

Conversion

Results

Education

V4

Edit

# Manage ©® Help

Knowledge Base

Available Topics

Search Results For "launching site to live"

Launching Your Site to Live h
Start Your Live Site Launch 4—

Launch to a Live Domain (Video)

How do | launch my site to a live domain name?
Footer Options in the Appearance Editor
Adding a Menu to a Menu Location

Can site notices be used on landing pages?

Add a Facebook Pixel to Your Site

% RAINMAKER PLATFORM



Need to migrate?

https:/my.newrainmaker.com/rainmaker-services/

Select the general service you need: *

o Site Migration 4—

Design-to-Theme Coding
Theme Modification

Site Setup Assistance

=

You must be logged into your my.newrainmaker.com customer account to access.

Email support@rainmakerplatform.com if you have questions.
7% RAINMAKER PLATFORM
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Get Quick Help

00 /4 Dashboard < Primility — Rain~ X o
< C (Y @ jerod-morris.preview111.rmkr.net/admin/ * W w JCOIN v |
74 + AddNew 2 Edit F Manage @ Help A¢  Greetings, jerod morris
Admin Screen Options
%
7
Dashboaro
Design A/B Tests v Google Analytics Summary v
Right Now in Forums v Membership Order History v
Content

Membership Order Summary

Traffic Membership Order Statistics

Membership Subscriptions Summary
Conversion

Results

Education
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%4 Dashboard < Primility — Rain~ X

Get Quick Help

C {y @ jerod-morris.preview111.rmkr.net/admin/

Dashboard

Design

Content

Traffic

Conversion

Results

Education

& Edit

/# Manage © Help

Dashboard

A/B Tests

Right Now in Forums

Goo

Mer

Me

Me

Me

Jerod

*x &N w el v

Greetings, jerod morris

How can we help you?

Knowledge Base
Quick Start Guides & How-To Articles

Your Account Portal

Manage your Rainmaker Platform account

Rainmaker Login Screens
Video Tutorial

How to Get Help

How to get help when you need it.

Quick Answers
Get answers to most common questions

W W ¢ W @

A/B Tests

Email Us

Admin Screen Options

\AINMAKER PLATFORM



Toggle Help Mode On

@ ' % Dashboard « Primility — Rain~ X Jerod

o
&« C () @ jerod-morris.preview111.rmkr.net/admin/ * o Moo

2 Edit S/ Manage @ Help 3 Greetings, jerod morris

Quick Help Admin Screen Options

Help Mode

Dashboard D h
a S Knowledge Base

Email Us

DeSign A/B Tests Your Account GOO}';'C AN J}’UCS Summa ry v

Right Now in | v Membership Order History v
Content
Membership Order Summary v
Traffic Membership Order Statistics v
Membership Subscriptions Summary v
Conversion
Results
[
Education

erocd-morris.preview111.rmkr.net/admin/?activate_help_mode=1&hm_nonce=38{4891e84
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Toggle Help Mode On

® '/ Dashboard « Primility — Rain~ X Jerod

< C ) @ jerod-morris.preview111.rmkr.net/admin/ . —

/é + AddNew ¢ Edit / Manage @ Help ' Greetings, jerod morris

Quick Help Admin Screen Options

%

Dashboard D a < h
X

When Help Mode is toggled "ON," you will see
convenient buttons throughout your
Design A/BT  Rainmaker dashboard that offer one-click v Google Analytics Summary v
assistance for various features. (Important:
Toggling "ON" or "OFF" will cause your
Right current screen to refresh, so SAVE YOUR v Membership Order History v
WORK before clicking.)

Help Mode

Content
Yes No Membership Order Summary N
Traffic Membership Order Statistics v
Membership Subscriptions Summary v
Conversion
Results
Education

(INMAKER PLATFORM

ierod-morris.oreview111.rmkr.net/admin/?activate helo mode=18&hm nonce=38f485feB4



Toggle Help Mode Off

® % Dashboard « Primility — Rain~ X Jerod

& C ) @ jerod-morris.preview111.rmkr.net/admin/?activate_help_mode=1&hm_nonce=381489fe84 v N o el v )

fé + AddNew 2 Edit /& Manage @ Help > Greetings, jerod morris

: Admin Screen Options
y/ Quick Help
%
Help Mod
Dashboard D h s
a S Knowledge Base
Email Us
Design A/B Tests Your Account Google Analytics Summary v
Right Now in _ v Membership Order History v
Content
Membership Order Summary v
el Membership Order Statistics v
Membership Subscriptions Summary v
Conversion
Results
Education

\INMAKER PLATFORM

larnnd_marrie nraviaw 111 renbr natiadmin!?nm nanca-T10A00Fa0 AR Aanntiuata haln mana-1



Using Help Mode

® '/ universal Settings < Primility - x Jerod

® O
& C (Y @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=general “w B w JColl v |

/é + AddNew 2 Edit / Manage @ Help i Greetings, jerod morris

%

Dashboard Setti ﬂgS a ‘

Design General Design Content Traffic Email Conversion Results Podcast Social
General Settings
Content
Here is where you can add your site's name and description,
and set your time zone. /
_ Learn more about the General Settings e the title of your new site goes, and will reflect in search engines and in your theme. For example,
Traffic ne of the Rainmaker site located at http://unemployable.com is Unemployable. Remember, you can
upuare-uny-later, SO you don't need to make it “perfect” today.
Conversion Add Your Site Description Create meaning by balancing pride and humility.
Your Site Description is your tagline. So, the Site Description for Unemployable is Resources for Freelancers and
Entrepreneurs. Google will display your Site Name plus the Site Description as the link to your home page in the
search results. Update it at any time.
Results P /
Set Your Time Zone UTC-6 -
Education

Choose a city in the same time zone as you.

©) Collapse menu UTCtimeis 2017-62-66 18:59:13

AINMAKER PLATFORM

Local time is 2017-62-06 12:59:13
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The Settings Gear Icon

@ '/ Dashboard « Primility — Rain~ X Jerod

o
— C ) @ jerod-morris.preview111.rmkr.net/admin/index.php w9 w Jcoll v |

74  + AddNew 2 Edit 4 Manage @ Help 30 Greetings, jerod morris

Admin Screen Options
/ General
%
Design
Dashboara )
a S O a Content
Traffic
Design A/B Tests v €lsl Email v
Conversion
Right Now in Forums v Mer S v
Content
Podcast
Me v
Social
Traffic Membership Order Statistics v
Membership Subscriptions Summary v
Conversion
Results
Education

77 HAINMAKER PLATFORM
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Navigating the Settings

## Universal Settings < Primility - X Jerod
C ) @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=general “w N w COll v
+ AddNew ¢ Edit / Manage @ Help Greetings, jerod morris
%
Sittings o
Design General . Design Content Traffic Email Conversion Results Podcast Social
General
Content
Add Your Site Name Primility
This is where the title of your new site goes, and will reflect in search engines and in your theme. For example,
Traffic the Site Name of the Rainmaker site located at http://unemployable.com is Unemployable. Remember, you can
update this later, so you don't need to make it “perfect” today.
Conversion Add Your Site Description Create meaning by balancing pride and humility.
Your Site Description is your tagline. So, the Site Description for Unemployable is Resources for Freelancers and
Entrepreneurs. Google will display your Site Name plus the Site Description as the link to your home page in the
h Its. Update it at time.
Results search results. Update it at any time
Set Your Time Zone UTC-6 :
Education

Choose a city in the same time zone as you.

UTCtimeis 2017-82-06 19:03:08

77 RAINMAKER PLATFORM
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Site Name

'44 Universal Settings < Primility - x '\ Jerod
C ) @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=general r N (o el V)
+ AddNew 2 Edit / Manage @ Help Greetings, jerod morris
4
7z
Settings =~ &
Design General Design Content Traffic Email Conversion Results Podcast Social
General
Content
Add Your Site Name Primility
) This is where the title of your new site goes, and will reflect in search engines and in your theme. For example,
Traffic the Site Name of the Rainmaker site located at http://unemployable.com is Unemployable. Remember, you can
update this later, so you don't need to make it “perfect” today.
Conversion Add Your Site Description Create meaning by balancing pride and humility.
Your Site Description is your tagline. So, the Site Description for Unemployable is Resources for Freelancers and
Entrepreneurs. Google will display your Site Name plus the Site Description as the link to your home page in the
e search results. Update it at any time.
Set Your Time Zone UTC-6 -
Education

Choose a city in the same time zone as you.

UTCtimeis 2017-02-06 19:03:08
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74 Universal Settings «< Primility - X

Site Description

Jerod

C (0 @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=general v N w [lcolll -

%
Dashboard

Design

Content

Traffic

Conversion

Results

Education

24

Edit

/# Manage ©® Help

Settings

General Design
General
Add Your Site Name

Add Your Site Description

Set Your Time Zone

Greetings, jerod morris

Content Traffic Email Conversion Results Podcast Social

Primility

This is where the title of your new site goes, and will reflect in search engines and in your theme. For example,
the Site Name of the Rainmaker site located at http://unemployable.com is Unemployable. Remember, you can
update this later, so you don'’t need to make it “perfect” today.

Create meaning by balancing pride and humility.

Your Site Description is your tagline. So, the Site Description for Unemployable is Resources for Freelancers and
Entrepreneurs. Google will display your Site Name plus the Site Description as the link to your home page in the
search results. Update it at any time.

UTC-6 v

Choose a city in the same time zone as you.

UTCtimeis 2017-82-06 19:03:08
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Set Time Zone

## Universal Settings < Primility - x

Jerod

C ) @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=general v N w JCOlN v

+ Add New

Dashboard

Design

Content

Traffic

Conversion

Results

Education

V24

Edit

/# Manage ©® Help

Settings

General Design

General

Add Your Site Name

Add Your Site Description

Set Your Time Zone

Greetings, jerod morris

Content Traffic Email Conversion Results Podcast Social

Primility

This is where the title of your new site goes, and will reflect in search engines and in your theme. For example,
the Site Name of the Rainmaker site located at http://unemployable.com is Unemployable. Remember, you can
update this later, so you don't need to make it “perfect” today.

Create meaning by balancing pride and humility.

Your Site Description is your tagline. So, the Site Description for Unemployable is Resources for Freelancers and
Entrepreneurs. Google will display your Site Name plus the Site Description as the link to your home page in the
search results. Update it at any time.

UTC-6 v

Choose a city in the same time zone as you.

UTCtimeis 2017-62-06 19:03:08
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Set Time Zone

GGo g|e what is utc time right now? L Q

All Maps News |Images Shopping More  Settings Tools

About 6,500,000 results (0.84 seconds)

7:06 PM

Tuesday, January 31, 2017
Coordinated Universal Time (UTC)

(Googled at 1:06 p.m. local time)

77 RAINMAKER PLATFORM



Set Time Zone

—

® @ ' 4 universal Settings < jerod-mc X | G Tahiti s

W |

o C O (Dierod-morris.preview111.rmk Tarawa itab TS 820 :
: Tongatapu :

Wake
. . . Wallis
O g Ie what is utc time right now?  Q UTC
uUTC
Manual Offsets
UTC-12
Alll Maps News |Images Shopping More  Settings Tools General a0
UTC-10:30
UTC-10
About 6,500,000 results (0.84 seconds) \ Add Your Site Name b
UTC-9
UTC-8:30 » and will reflect in search
UTC-8 2e Site Name of the

o UTC-7:30 oble.com is Unemployable.
7 O 6 P M uTtc-7 Ju don't need to make it
* UTC-6:30
Tuesday, January 31, 2017 UTC-5:30
. . . UTC-5
Coordinated Universal Time (UTC) 2. Add Your Site Description UTC-4:30 ‘and humnility.
uTC-4
UTC-3:30 2 Site Description for
UTC-3 i and Entrepreneurs. Google

UTC-2:30 iscription as the link to your
UTC-2 at any time.

(Googled at 1:06 p.m. local time) e

UTC-0:30 1

-~

digH PINd

3. Set Your Time Zone / UTC+0

UTC+0:30

UTC+1 L
UTC+1:30

UTC+2

UTC+2:30

UTC+3

UTC+3:30

UTC+4

Save and Continue UTC+4:30
UTC+5

UTC+5:30
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Other General Settings

74 Universal Settings < Primility - X Jerod

C {0 @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=general w u w lcolll v

+ AddNew ¢ Edit / Manage @ Help iy Greetings, jerod morris

Your Site Description is your tagline. So, the Site Description for Unemployable is Resources for Freelancers and
Entrepreneurs. Google will display your Site Name plus the Site Description as the link to your home page in the

search results. Update it at any time.
Results P 4

Set Your Time Zone UTC-6 -

Education Choose a city in the same time zone as you.

UTCtimeis 2017-62-66 19:03:08

Local time is 2017-02-06 13:03:08

Configure HTTPS HTTPS is not available on preview sites. After making your site live in your Rainmaker Account Portal, you will
find an option to "Request SSL."”

Enable Rainmaker Labs
By enabling this option you will activate a new settings tab where you can try out cutting-edge

features we are developing and testing for possible inclusion in future Rainmaker releases. We
want your feedback on these features, what works and what doesn't, so please feel encouraged

to provide feedback here about Labs features. NOTE: Rainmaker Labs is an experimental

feature set. You use these features at your own risk. However, if you do have an issue with a

Rainmaker Labs feature, disable it and let us know immediately.

77 RAINMAKER PLATFORM
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Set up Google Analytics

® @ '/ universal Settings < Primility - x || Jerod

\ )

& C ) @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=results w N w colll v )

é/ + AddNew ¢ Edit & Manage @ Help

Dashboard Setti ngS

Design General Design Content Traffic Email Conversion Results Podcast Social

Google Analytics @
Content

Connect with Google Setup Google Account 4—

Traffic

Save

Conversion

I

Results

Education

+z RAINMAKER PLATFORM



Set up Google Analytics

®eCe® > Request for Permission % \

— I 0 @ Secure https://accounts.google.com/o/oauth2/auth?response_type=code&redirect_uri=http%3A%2F%2Foauth.newrainmaker.com%2Fauthorization%:

Google

® 7

-~ Rainmaker Platform would like to:

@ Have offline access

77 RAINMAKER PLATFORM



Set up Google Analytics

® ' % uUniversal Settings « Primility - x |

® O
& C 0 © jerod-morris.preview111.rmkr.net/admin/admin.php?page=universal-settings&tab=results&debug=display&code=4%2FTYdvyVNTHfeXiySZgkLSNSewnAOyeZ7.. &x 8N w COlN v |

Jerod

¢ Edit /4 Manage ©® Help

Dashboard

Design

Content

Traffic

Conversion

I

Results

Education

Settings

General Design Content Traffic Email Conversion Results Podcast Social

Google Analytics @

Google is Configured Re-Authenticate Google Account Remove Google Authentication

Select Web Property pnmllltvcom v b

. DI

77 RAINMAKER PLATFORM
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Edit Your Admin User Profile

~ @ ' % Dashboard « Primility — Rain~ X Jerod

O
& C ) @ jerod-morris.preview111.rmkr.net/admin/ * @B w Jcoll v

%) + AddNew 2 Edit # Manage @ Help 3¢ Greetings, jerod morris

/ . »
74 Jerod morris
‘ K erod@copyblogger.com
Dashboara
Log Out
Design A/B Tests v Google Analytics Summary v
Right Now in Forums v Membership Order History v
Content
Membership Order Summary v
Traffic Membership Order Statistics v
Membership Subscriptions Summary v
Conversion
Results
Education

ernd-marris neoview 111 rmkr natiadmin/onrafile nhn
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% Profile < Primility — Rainmake X

C {0 @ jerod-morris.preview111.rmkr.net/admin/profile.php

+ Add New

Dashboard

Design

Content

Traffic

Conversion

Results

Education

& Edit

# Manage

© Help

Profile

Personal Options

Visual Editor

Keyboard Shortcuts

Toolbar

Name

Username

First Name

Last Name

Disable the visual editor when writing

Enable/Disable Visual Editor

Enable keyboard shortcuts for comment moderation. More information

Show Toolbar when viewing site

jerod@copyblogger.com

jerod

morris

Usernames cannot be changed.

Jerod

Y % 9 (w JcEll

Greetings, jerod morris
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Enable/Disable Visual Editor

Add New POSt + vew

This is the headline of a post

Permalink:

Edit View Post

Enabled
07 Add Media

Visual Text
B o €K — = = = & R =

I = =
= F N B € O <©

This is a test link.|

texturl.com X

77 RAINMAKER PLATFORM




Enable/Disable Visual Editor

Add New Post » v Add New Post » v

This is the headline of a post This is the headline of a post

Permalink: Permalink:

Edit View Post Edit View Post

Enabled
9; Add Media 0; Add Media .
Visual Text Disabled
B I #= = £ ¢ — = = = || R = b i link b-quote del ins img wul ol li code more
= B ‘ B o e closetags Copy HTML =
<a href="http://texturl.com” target=" blank">This is a test link.
. . . </a>
This is a test link,|

texturl.com X

+—eerereeeeKER PLATFORM
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Enable/Disable Toolbar (When Viewing Site)

% Profile < Primility — Rainmake X

C ) @ jerod-morris.preview111.rmkr.net/admin/profile.php

+ Add New

Dashboard
Design
Content
Traffic
Consion

Results

Education

74

Edit

# Manage ©® Help

Profile

Personal Options

Visual Editor

Keyboard Shortcuts

Toolbar

Name

Username

First Name

Last Name

Disable the visual editor when writing

Enable keyboard shortcuts for comment moderation. More information

v Show Toolbar when viewing site

jerod@copyblogger.com

jerod

morris

Usernames cannot be changed.

Greetings, jerod morris
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Enable/Disable Toolbar (When Viewing Site)

® © ® ' % primiity - Create meaning by X Jerod ® © @ /7 primiity - Create meaning by - X

C Y @ jerod-morris.preview111.rmkr.net o 9 w Ol

C )y @ jerod-morris.preview111.rmkr.net w9 (w JCOIN v B

No Toolbar Here is a good place for a call to action. // + AddNew 2 Edit / Manage @ Help

With TOOIbar Here is a good place for a call to action.
PRIMILITY

PRIMILITY

GRAB ATTENTION

This is a good place to grab attention. Use a small piece.of copy to

GRAB ATTENTION

This is a good place to grab attention. Use a small piece of copy to lead your

lead your visitor to want to find out more.

visitor to want to find out more.
MORE ABOUT US

MORE ABOUT US

OUR THOUGHTS

What is your company philosophy? Why should we be interested in you?
OUR THOUGHTS

What is your company philosophy? Why should we be interested in you?
COMPANY BLOG

77 RAINMAKER PLATFORM



Add Short Bio

= @ | % Profile < Primility — Rainmake X Jerod

o
< C (Y @ jerod-morris.preview111.rmkr.net/admin/profile.php P &% B w el v

Add New ¢ Edit /& Manage ©® Help

Greetings, jerod morris

About Yourself

Biographical Info Jerod Morris is the VP of Marketing for <a

href="http://rainmakerdigital.com" target="_blank">Rainmaker Digital</a>
and hosts <a href="http://showrunner.fm" target="_blank">The

-------------------------

meaning in their lives through the practice of balancing pride and humility.

Share a little biographical information to fill out your profile. This may be shown publicly.

Account Management

New Password Generate Password
Confirm Password Confirm use of weak password
Sessions

Log Out Everywhere Else

You are only logged in at this location.

SEO Settings
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Add Short Bio to Posts and Author Archive

74 Profile < Primility — Rainmaks X

C Y @ jerod-morris.preview111.rmkr.net/admin/profile.php

+ Add New

V4

Edit

/# Manage ©® Help

Custom Archive Headline

Will display in the <h1> tag at the top of the first page

Custom Description Text

This text will be the first paragraph, and display on the first page
Author Box v Enable Author Box on this Member's Posts?
v Enable Author Box on this Member's Archives?

Layout Settings

These settings apply to this author's archive pages.
Choose Layout » Default Layout set in Design Settings

Update Profile

Jerod

T % N w ol V)

Greetings, Jerod Morris
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C {0 @ jerod-morris.preview111.rmkr.net/test-post

+ Add New ¢ Edit /# Manage ©® Help Edit Post

PRIMILITY HOME  ABOUT

Add Short Bio to Posts and Author Archive

74 This is a test post. - Primility X

BLOG LIBRARY CONTACT

YOU ARE HERE: HOME / UNCATEGORIZED / THIS IS A TEST POST.

This is a test post.

FEBRUARY 6, 2017 BY JEROD MORRIS — LEAVE A COMMENT (EDIT)

This is some text for the post.

FILED UNDER: UNCATEGORIZED

About Jerod Morris
Jerod Morris is the VP of Marketing for Rainmaker

Digital and hosts The Showrunner podcast. He also
strives to help people create more meaning in their lives through the

practice of balancing pride and humility.

EMAIL NEWSLETTER

Your email newsletter is a
valuable asset. Get people
to sign up by offering

iIncentives!

SIGN UP

RECENT POSTS

This is a test post.

Example Blog Post

SOCIAL ICONS

77 RAINMAKER PLATFORM



Add Short Bio to Posts and Author Archive

o © 7 Jerod Morris, Author at Primi! X

& 2 C Y @ jerod-morris.preview111.rmkr.net/author/jerod-morris/

// + AddNew 2 Edit /# Manage ® Help

Here is a good place for a call to action.

PRIMILITY

ABOUT

BLOG LIBRARY CONTACT

YOU ARE HERE: HOME / ARCHIVES F@R JEROD MORRIS

About Jerod Morris
Jerod Morris is the VP of Marketing for Rainmaker Digital and hosts

The Showrunner podcast. He also strives to help people create

more meaning in their lives through the practice of balancing pride and humility.

This is a test post.

FEBRUARY 6, 2017 BY JEROD MORRIS — LEAVE A COMMENT (EDIT)

This is some text for the post.

EMAIL NEWSLETTER

Your email newsletter is a
valuable asset. Get people to

sign up by offering incentives!

SIGN UP

RECENT POSTS

This is a test post.

77 RAINMAKER PLATFORM



Logout All Sessions

® ' % profile « Primility — Rainmake X Jerod

®
& C ) @ jerod-morris.preview111.rmkr.net/admin/profile.php Y &% B (w JCEll v

é/ + Add New ¢ Edit /& Manage ©® Help

Greetings, jerod morris

About Yourself

Biographical Info Jerod Morris is the VP of Marketing for <a
href="http://rainmakerdigital.com" target="_blank">Rainmaker Digital</a>
and hosts <a href="http://showrunner.fm" target="_blank">The

meaning in their lives through the practice of balancing pride and humility.

Share a little biographical information to fill out your profile. This may be shown publicly.

Account Management

New Password Generate Password

Confirm Password Confirm use of weak password

Sessions Log Out Everywhere Else 4-__

You are only logged in at this location.

SEO Settings
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Default Pages

® © ® 4 pages « Primility — Rainmake X

< C ) @ jerod-morris.preview111.rmkr.net/admin/edit.php?post_type=page

74  + AddNew

¢ Edit /# Manage ©® Help

Dashboard

Design

Content

Traffic

Conversion

Results

Education

Pages

All (13) | Published (12) | Draft (1)

Bulk Actions Apply

Title

About

Affiliate Area

Archives

Blog

Checkout

Sort by Order

All dates

Filter

Author

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

Search Pages

Date

2014/01
/24
Publish
ed

2014/09
/11
Publish
ed

2014/04
/09
Publish
ed

2014/01
/24
Publish
ed

2014/01
122

13 items

ID

15

340
80

19

; 77 RAINMAKER PLATFORM



Edit Your About Page

O #4 Pages « Primility — Rainmake X

®0
& C ) @ jerod-morris.preview111.rmkr.net/admin/edit.php?post_type=page

74 + AddNew 2 Edit

/# Manage

©® Help

Sort by Order

Dashboard
2ages
Design All (13) | Published (12) | Draft (1)
=n
Bulk Actions ~ Apply All dates
Content
Title
Traffic About
Edit Quick Edit
Conversion
A¥filiate Area
Results
Archives
Education
Blog

laend mmare’n nemilmut 14 conlic natinden’alonat ahaBeanse ACD antlan_n

Checkout

Filter

Trash View Duplicate Purge cache

Author

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod

Search Pages

Date

2014/01
/24
Publish
ed

2014/09
11
Publish
ed

2014/04
/09
Publish
ed

2014/01
124
Publish
ed

2014/01

13 items

ID

15

340

80

19
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Edit Your About Page

®  / Edit Page < Primility — Rainm X

® O
& C ) @ jerod-morris.preview111.rmkr.net/admin/post.php?post=15&action=edit

é/ + Add New

2 Edit /4 Manage ©® Help View Page

Dashboard

Design

Content

Traffic

Conversion

Results

Education

Edlt Dage 2 ViewAl

About

Permalink: je nort wview111 r.ne Edit
View Page  Get Shortlink

8; Add Media

sme = = €6 —

= N B € O © b

B~
N

A Compelling Headline to Introduce Your
Website’s Unique Appeal

Welcome to [Name of Your Website or Business] — the answer
to the question your prospects are looking for.

[A photo of your founder or employees is recommended to
personalize this page]

A smart About Page is an important part of keeping the
attention of your audience. It’s one of the first things visitors

look at when they find your website, and it can convert them

Publish A

3 Preview Changes

¥ Status: Published Edit
@ Visibility: Public Edit

i Published on: Jan 24, 2014 @
20:22 Edit

® SEO: N/A

Move to Trash

Page Attributes A

Parent

77 RAINMAKER PLATFORM



Create a Killer About Page

ARE YOU MAKING THESE 7 MISTAKES WITH YOUR ABOUT PAGE?

by Sonia Simone

http://rainmakerplatform.com/go/about1/

77 RAINMAKER PLATFORM



Create a Killer About Page

ARE YOU MAKING THESE 7 MISTAKES WITH YOUR ABOUT PAGE?

by Sonia Simone

http://rainmakerplatform.com/go/about1/

THE 5-STEP PROCESS FOR WRITING AN ABOUT

PAGE THAT CONNECTS (AND CONVERTS)
by Leanne Regalla

http://rainmakerplatform.com/go/about?2/

77 RAINMAKER PLATFORM



Edit Your Contact Page

o %4 Pages ¢ Primility — Rainmake X

O
& C ) @ jerod-morris.preview111.rmkr.net/admin/edit.php?post_type=page

/ Manage ©® Help

74  + AddNew 2 Edit

Blog

Checkout

Contact

Edit Quick Edit Trash View Duplicate Purge cache

Example Icon Links

Form Preview Page - DO NOT DELETE - Draft

Free Member Content Library

Join Our Free Content Library Membership

larad_mareie rraviaw1 11 renbr natladmininnct nhin?anct- 172 antinn-andls

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

Jerod
Morris

2014/01
/24
Publish
ed

2014/01
/22
Publish
ed

2014/01
/24
Publish
ed

2014/04
/15
Publish
ed

2015/11
/02
Last
Modifie
d

2014/02
/03
Publish
ed

2014/02
/03
Publish
ed

17

116

59

57

77 RAINMAKER PLATFORM



Edit Your Contact Page

® © ® 4 EditPage « Primility — Rainm- X Jerod

& C ) @ jerod-morris.preview111.rmkr.net/admin/post.php?post=17&action=edit “ o v el v

é/ 4+ Add New ¢ Edit /# Manage ©® Help View Page

Dashboard Ed it Dage 2 View Al

Design
Contact Publish A
E Permalink: rod-n view111.rmkr.ne Edit e B
Content View Page  Get Shortlink
? Status: Published Edit
0; Add Media |
i Vi Text
Traffic sue ¢ ® Visibility: Public Edit
B I #= = £ ¢ — = = = & R
Revisions: 4 Browse
= &= F N B € O © bt
Conversion .
111, Published on: Jan 24, 2014 @
20:24 Edit
Contact [Your Business or Brand]
Results This is the page your readers and prospects will visit if they @ SEO:N/A

have specific questions or want to get in touch with you

directly. Move to Trash

Education Make sure that your copy is brief, professional, and clearly
states how contacting you through this page is handled. It can Update

help to offer links to specific support pages for FAQs.

It is smart to have users contact you through the built-in form Page Attributes -

this page, instead of revealing an email address that can be
?.I.ln:lilj:ge instead of revealing an email address that can be // RAINMAKER PLATFORM



Add a Form to Your Contact Page

= @ ' % Edit Page « Primility — Rainm- X Jerod

(0]
& C ) @ jerod-morris.preview111.rmkr.net/admin/post.php?post=17&action=edit v N (w el )

/é + Add New ¢ Edit /& Manage ©® Help View Page

= Freview anges

Permalink: /lje view111 ne Edit
Content View Page Get Shortlink
? Status: Published Edit
0; Add Media I
i Vi Text
Traffic sue : ® Visibility: Public Edit
B I %= = £ ¢ — = = = & &
} Revisions: 4 Browse
. = N B € o © -
Conversion -
11, Published on: Jan 24, 2014 @
20:24 Edit
Contact [Your Business or Brand]
Results This is the page your readers and prospects will visit if they @ SEO: N/A
have specific questions or want to get in touch with you
directly. Move to Trash
Education Make sure that your copy is brief, professional, and clearly
states how contacting you through this page is handled. It can
help to offer links to specific support pages for FAQs.
It is smart to have users contact you through the built-in form Page Attributes -
’ on this page, instead of revealing an email address that can be
spammed.
Parent

The form can be customized to include any number of fields

(no parent) -

you wish to gather from users (Content > Content Tools >
FOl'mS > Edit > Contact). Temp'ate

You can also auto-generate a reply email to users who fill out Default Template »
the form, and set up the page to show users a successful

submission message. Order é/ R A I N M A K E R P I. AT FO R M



Find Default Contact Form

® © ® 4 EditPage « Primility — Rainm- X

& C ) @ jerod-morris.preview111.rmkr.net/admin/post.php?post=17&action=edit

& Edit & Manage

// + Add New

Comments

Forum Topics

Traffic Forum Replies
Forms
Site Notices
Conversion
Members
Affiliate Payments
A/B Testin
Results g
Quizzes
Education

Word count: 0

Layout Settings

Select Layout

arod-morris.oreview 11 1.rmkr.net/admin/admin.ohn?pace~ninia-forms

N Haln

\/iew: Daoca

Visual Text
s = = R
< > l-ﬁ

Last edited on September 10, 2014 at 7:56 PM

Default Layout set in

MaAacinm CAtéinme

? Status: Published Edit

@ Visibility: Public Edit

Revisions: 4 Browse

i1 Published on: Jan 24, 2014 @
20:24 Edit

® SEO:N/A

Move to Trash

Page Attributes A

Parent

(no parent)
Template

Default Template

Order

77 RAINMAKER PLATFORM



Copy Form Shortcode

o 74 < Primility — Rainmaker Platfc X Jerod

@
& C Y @ jerod-morris.preview111.rmkr.net/admin/admin.php?page=ninja-forms W N [ COlN

éé + Add New ¢ Edit /4 Manage ©® Help

Dashboard
FOrms
Design
All (1)
=0
Bulk Actions Appl 20 v A Per P Go 1-10f 1 Form
Content PPly orms Per Page f
Form Title Shortcode Date Updated
Traffic
Contact [display_form id=1] May 15, 2014
Edit Delete Duplicate Preview
Form View Submissions
Conversion
Form Title Shortcoge Date Updated
Results
Copy
Education

7 RAINMAKER PLATFORM



Paste Contact Form Shortcode Into Page

© @ | % Edit Page < Primility — Rainm- X Jerod

@)
— C ) @ jerod-morris.preview111.rmkr.net/admin/post.php?post=17&action=edit&revision=65 w 9 w Cell v )

/é + Add New ¢ Edit /# Manage ©® Help View Page

Admin Screen Options

Dashboard :d it Page # View All

Design
E Permalink: htt: fow iy Edit C3 Preview Changes
Content View Page Get Shortlink
? Status: Published Edit
8 Add Media I
i Vi Text
Traffic sua o @ Visibility: Public Edit
B I #= = = ¢ — = = = @ R
Revisions: 4 Browse
= &= * N B € O © e
Conversion .
11l Published on: Jan 24, 2014 @
20:24 Edit
[dlbpld\ form id= 1] ?
Results ® SEO:N/A

Move to Trash

Education
Update

Page Attributes A
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Preview Page and Test Form

74 Contact - Primility b

C {0 @ jerod-morris.preview111.rmkr.net/contact/?preview=true
+ AddNew & Edit # Manage © Help  Edit Page

Your email newsletter is a

valuable asset. Get people to

Conta ct sign up by offering incentives!

Fields marked with a * are required.
First Name *

v ¢ It “‘y‘

SICN UP

RECENT POSTS

Last Name *

This is a test post.

Email * Example Blog Post

SOCIAL ICONS

commancs EoEan

SEARCH FORM

SUBMIT

Jerod

Q| B | JCEl

Greetings, Jerod Morris  Q
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Questions?

7,
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Upcoming Sessions

Q&A on Rainmaker’s Basic Settings with
Chris Garrett and Jerod Morris
Wednesday, February 15 at 4:00 p.m. ET

7/ RAINMAKER PLATFORM
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Upcoming Sessions

Q&A on Rainmaker’s Basic Settings with
Chris Garrett and Jerod Morris
Wednesday, February 15 at 4:00 p.m. ET

How to Choose the Best Theme for Your
Rainmaker Site (with Rafal Tomal)
Wednesday, February 22 at 11:00 a.m. ET

7/ RAINMAKER PLATFORM



%

77 RAINMAKER PLATFORM



http://newrainmaker.com

